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What is EMF?

= A modeling & data integration framework
= Exploits the facilities offered in Eclipse to...

» (Generate code without losing user customizations (merge)

Automate important tasks (such as registering the runtime
information)

» Improve extensibility
= Provide a Ul layer

= What is an EMF “model”?

= Specification of your application’s data
= Object attributes

» Relationships (associations) between objects
= Operations available on each object

= Simple constraints (eg. cardinality) on objects and relationships
Essentially it represents the class diagram of the application
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What does EMF Provide?

= From a model specification, EMF can generate efficient, correct,
and easily customizable implementation code

= Out of the box, EMF provides support for
= Java™ interfaces
= UML
= XML Schema
= EMF converts your models to Ecore (EMF metamodel)

» Tooling support within the Eclipse framework (Ul, headless
mode, Ant and standalone), including support for generating
Eclipse-based and RCP editors

» Reflective API and dynamic model definition

= Persistence API with out of box support for XML/XMI
(de)serialization of instances of a model

= And much more....
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Why EMF?

= EMF is middle ground in the modeling vs. programming worlds
» Focus is on class diagram subset of UML modeling (object model)
» Transforms models into Java code
* Provides the infrastructure to use models effectively in your
application
= Very low cost of entry
= EMF is free and open source
» Full scale graphical modeling tool not required
» Reuses your knowledge of UML, XML Schema, or Java

= |t’s real, proven technology (since 2002)
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EMF History

= First version was released in June, 2002
Originally based on MOF (Meta Object Facility)
* From OMG (Object Management Group)

= Abstract language and framework for specifying, constructing, and
managing technology neutral metamodels

EMF evolved based on experience supporting a large set of tools
= Efficient Java implementation of a practical subset of the MOF API
2003: EMOF defined (Essential MOF)
= Part of OMG’s MOF 2 specification; UML2 based

= EMF is approximately the same functionality
= Significant contributor to the spec; adapting to it
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Who is Using EMF Today?

= Eclipse projects
» Tools Project: UML2 and Visual Editor (VE)
= Web Tools Platform (WTP) Project
» Test and Performance Tools Platform (TPTP) Project

» Business Intelligence and Reporting Tools (BIRT) Project
» Data Tools Platform (DTP) Project

» Technology Project: Graphical Modeling Framework (GMF)
= Commercial offerings

= |BM, Borland, Oracle, Omondo, Versata, MetaMatrix, Bosch,
Ensemble...

= Large open source community
= Estimated 125,000 download requests in January
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EMF at IBM

» Pervasive usage across product lines
= |BM® Rational® Software Architect
= |BM Rational Application Developer for WebSphere Software
= |BM WebSphere® Integration Developer
= |IBM WebSphere Application Server
= |BM Lotus® Workplace

* Emerging technology projects: alphaWorks

= Emfatic Language for EMF Development
(http://lwww.alphaworks.ibm.com/tech/emfatic)

= Model Transformation Framework
(http://lwww.alphaworks.ibm.com/tech/mtf)

» XML Forms Generator (http://www.alphaworks.ibm.com/tech/xfg)
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What Have People Said About EMF?

= EMF represents the core subset that's left when the non-essentials are
eliminated. It represents a rock solid foundation upon which the more
ambitious extensions of UML and MDA can be built.

— Vlad Varnica, OMONDO Business Development Director, 2002

» EMF provides the glue between the modeling and programming worlds,
offering an infrastructure to use models effectively in code by integrating UML,
XML and Java. EMF thus fits well into [the] Model-Driven Development approach
and is critically important for Model-Driven Architecture, which underpins
service-oriented architectures [SOA].

— Jason Bloomberg, Senior analyst for XML & Web services, ZapThink, 2003

» The EMF [...] with UML stuff is pretty cool in Eclipse. Maybe one day MDA will
make its way into the NetBeans GUI.

— posted to theserverside.com, November 2004 (circa NetBeans 4.1 EA)

= [As] a consultant with fiduciary responsibility to my customers, [...] given the
enormous traction that Eclipse has gathered, we have to view the EMF
metadata management framework as the de facto standard.

— David Frankel, as seen in Business Process Trends, March 2005
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Creating the Ecore Model

» Representing the modeled domain in Ecore is the first step in
using EMF
= Ecore can be created
» Directly using the EMF editors
» Through a graphical Ul provided by external contributions

» By converting a model specification for which a Model Importer is
available

Model Importers available in EMF
= Java Interfaces
= UML models expressed in Rational Rose® files
= XML Schema

» Choose the one matching your perspective or skills
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Model Importers Available in EMF

= Java Interfaces

public interface PurchaseOrder

{
String getshipTo(Q);
void setShipTo(String value);
String getBillToQ;
void setBillTo(String value);
List getlitems(); // List of Item

public interface I[tem
{
String getProductName();
void setProductName(String value);
int getQuantity(Q;
void setQuantity(int value)
float getPrice();
void setPrice(float value);

}
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Model Importers Available in EMF

= UML Class Diagram

PurchaseQrder d Ctl\lltem Stri

| _ - roductName : Strin
shipTo : String P tems guantity - int Y
bilTo : String 0.* | price : fioat
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Model Importers Available in EMF

= XML Schema

<?xml version="1.0" encoding=""UTF-8"7?>
<xsd:schema xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
targetNamespace=""http://www.example.com/SimplePO""
xmIns:PO=""http://www.example.com/SimpleP0"">
<xsd:complexType name=""PurchaseOrder">
<xsd:sequence>
<xsd:element name="'shipTo" type="'xsd:string'/>
<xsd:element name="billTo" type="xsd:string'/>
<xsd:element name=""items"™ type="PO:Iltem"
minOccurs="0" maxOccurs=""unbounded'/>
</xsd:sequence>
</xsd:complexType>
<xsd:complexType name="1tem">
<xsd:sequence>
<xsd:element name=""productName"™ type="'xsd:string'/>
<xsd:element name="‘quantity" type="'xsd:int'/>
<xsd:element name=""price" type="xsd:float"/>
</xsd:sequence>
</xsd:complexType>
</xsd:schema>
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Unifying Java, XML and UML Technologies

= The Model Importers available in EMF were carefully chosen to
integrate today’s most important technologies
= All three forms provide the same information
» Different visualization/representation
= The application’s “model” of the structure
* From a model definition, EMF can generate
» Java implementation code, including Ul
= XML Schemas
= Eclipse projects and plug-in
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Typical EMF Usage Scenario

Create an Ecore model that represents the domain you are working on
* |mport UML (e.g. Rose .mdl file)
» Import XML Schema
» Import annotated Java interfaces
» Create Ecore model directly using EMF's Ecore editor or a graphical editor
Generate Java code for model

Prime the model with instance data using generated EMF model editor

Iteratively refine model (and regenerate code) and develop Java
application

* You will use the EMF generated code to implement the use cases of your
application

Optionally, use EMF.Edit to build customized user interface
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EMF Components

= EMF Core
= Ecore metamodel
= Model change notification & validation
» Persistence and serialization
» Reflection API
» Runtime support for generated models

= EMF Edit
» Helps integrate models with a rich user interface
= Used to build editors and viewers for your model
* [ncludes default reflective model editor
= EMF Codegen
= Code generator for core and edit based components
» Extensible model importer framework
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EMF Tools: Model Import and Generation

Generator Features:

= Customizable
JSP-like
templates (JET)

= JDT-integrated,
command-line, or
Ant

» Fully supports
regeneration and
merge

ava
ditor*

Java Java N
model edit e * Eclipse IDE-integrated
or RCP-based
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EMF Model Importers

= UML

= Rational Rose .mdl file

= Eclipse UML2 project provides importer for .uml2
Annotated Java

» Java interfaces representing modeled classes

» Javadoc annotations using @model tags to express model
properties not captured by method declarations

= Lowest cost approach
XML Schema

» Describes the data of the modeled domain

» Provides richer description of the data, which EMF exploits
Ecore model (*.ecore file)

= Just creates the generator model (discussed later)

= Also handles EMOF (*.emof)
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Ecore Model Creation

= An Ecore model is created within an Eclipse project via a wizard

» [nput: one of the model specifications from the previous slide
= QOutput:
» modelname.ecore
= Ecore model file in XMI format
= Canonical form of the model
» modelname.genmodel
A “generator model” for specifying generator options
Decorates .ecore file
EMF code generator is an EMF .genmodel editor
Automatically kept in synch with .ecore file
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Ecore Model Editor

= A graphical editor is a better approach
» GMF Ecore Diagram Example (http://www.eclipse.org/gmf/)
= Omondo EclipseUML (http://www.omondo.com/)
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EMF Generator

B PurchaseCrder.genmadel %
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The Ecore (Meta) Model

= Ecore is EMF's model of a model
= Also called a “metamodel”
= Persistent representation is XMl

eSuperTypes
0" EAttrlbut'e eAttribute Type EDataType
eAttributes  |name : String 1 name : String
EClass 0 *
name : String i
eReferences EReference

0 * ~|name: String
containment : boolean

1 | eReferenceType lowerBound : int
upperBound : int

eOpposite | 0..1
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The Ecore Metamode

EChject
ElodelElement
EFactory ENarmedElement
| | | |
EPackage EClassifier EEnumLiteral ETvpedErment
Ellass EDataType EStucturaFe ature ECperation EFarameter
% | |
EEnum EAttribute EReference

= EObject is the root of every model object — equivalent to java.lang.Object
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Partial List of Ecore Data Types

Ecore Data Type Java Primitive Type or
Class

EBoolean boolean

EChar char

EFloat float

EString java.lang.String

EByteArray byte[ |

EBooleanObject java.lang.Boolean

EFloatObject java.lang.Float

EJavaObiject java.lang.Object

= Ecore data types are serializable and custom data types are supported
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Ecore Model for Purchase Orders

PurchaseOrder Item - ; ted in E
shioTo : Strin items productName : Stnng |S represen e |n Core aS
blll-?o ] Strlngg N quant'ty : |nt ------------------------ :
i 0.. price : float
EClass EClass
(name="PurchaseOrder") (name="Item")

i \ eReferenceType

EAttribute EAttribute EReference EAttribute
(name="shipTo") (name="billTo") (name="items") (name="productName")
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Purchase Order Ecore XMl

<eClassifiers xsi:type="ecore:EClass"
name=""PurchaseOrder">
<eReferences name="i1tems" eType="#//1tem"
upperBound="-1" containment=""true'/>
<eAttributes name="'shipTo"
eType="ecore:EDataType http:...Ecore#//EString"/>
<eAttributes name="billTo"
eType="‘ecore:EDataType http:...Ecore#//EString'/>
</eClassifiers>

= Alternate serialization format is EMOF (Essential MOF) XMl

» Part of OMG Meta Object Facility (MOF) 2.0 standard
(http://www.omg.org/docs/ptc/04-10-15.pdf)
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UML Constructs Available in Ecore

= Classes, Abstract Classes, and Interfaces

ClassName AbstractClassName <<interface==
InterfaceName

= Attributes and Operations

ClassOrinterfaceName

attributel : typel
attribute2 : type2 = initval
<<0..*>> attribute3 : type3

operationl(argl : typel) : returnl
operation2(argl : typel, arg2 : type2) : return2
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UML Constructs Available in Ecore

» References (Associations)

= One-way
ClassA roleBl_| classB
1
ClassA roleB2_ | ClassB
0..1
ClassA roleB3 | classB
0.*
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UML Constructs Available in Ecore

» References (Associations)
= Bidirectional

ClassA | ToleA roleB | classB
1 0.*
= Containment
ClassA roleBl | classB
0.*
ClassA roleA roleB2 | classB
0.*

32 Introduction to the Eclipse Modeling Framework | © 2006 by IBM; _



.@pa 2CON 2006

UML Constructs Available in Ecore

= Class Inheritance

ClassA ClassA ClassC
<<extend>>
ClassB ClassB

= Enumerations and Data Types

<<enumeration>> <<datatype>>

| EnumName DataTypeName
I!terall <<javaclass>> JavaClassl
literal2

literal3 = 5
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Code Generation

= EMF framework is lightweight
» Generated code is clean, simple, efficient
= EMF can generate
= Model implementation
» Ul-independent edit support
= Editor and views for Eclipse IDE-integrated or RCP application
= JUnit test skeletons
» Manifests, plug-in classes, properties, icons, etc.
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Generated Model Code

» Interface and implementation for each modeled class
» Includes get/set accessors for attributes and references

public Interface PurchaseOrder extends EObject

{
String getshipToQ;

void setShipTo(String value);
String getBillToQ;

void setBillTo(String value);
EList getltems(Q);

» Usage example

order.getltems().add(item);
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Generated Model Code

» Factory to create instances of model objects

POFactory factory = POFactory.elNSTANCE;
PurchaseOrder order = factory.createPurchaseOrder();

» Package class provides access to metadata

POPackage poPackage = POPackage.elNSTANCE;
EClass 1temClass = poPackage.getlitem();

EAttribute priceAttr = poPackage.getltem Price();
//0or i1temClass.getEStructuralFeature(POPackage. ITEM PRICE)

= Also generated: switch utility, adapter factory base, validator,
custom resource, XML processor
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Generated Edit/Editor Code

» Viewing/editing code divided into two parts

» Ul-independent code
= |tem providers (adapters)
= |tem provider adapter factory

» Ul-dependent code
» Model creation wizard
= Editor
= Action bar contributor
= Advisor (RCP)

» By default each part is placed in a separate Eclipse plug-in
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Summary of Generated Artifacts

= Model = Editor
» [Interfaces and classes » Model Wizard
» Type-safe enumerations = Editor
» Package (metadata) = Action bar contributor
= Factory » Advisor (RCP)

= Switch utility

= Adapter factory base " Tests
= Validator " Test ca§es
= Test sulte

= Custom resource
= XML Processor

= Edit (Ul independent) . Manifests, plug-in classes,

» [tem provider adapter factory

39 | Introduction to the Eclipse Modeling Framework | © 2006 by IBM; _
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Regeneration and Merge

» Hand-written code can be added to generated code and
preserved during regeneration

» This merge capability has an Eclipse dependency, so is not
available standalone

= All generated classes, interfaces, methods and fields include
@generated marker in their Javadoc
* To replace generated code:
» Remove @generated marker
= Orinclude additional text, e.g.
@generated NOT

* Methods without @generated marker are left alone during
regeneration
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Regeneration and Merge

= Extend (vs. replace) generated method through redirection
= Append “Gen” suffix to the generated method's name

/ *x

* <l-- begin-user-doc -->
* <I-- end-user-doc -->
* @generated

*/

public String getName()

{

}

return name;

/**

* <l-- begin-user-doc -->
* <I-- end-user-doc -->
* @generated

*/

public String getNameGen()
{

return name;

}

public String gethName()

{
return format(getNameGen());

}

Introduction to the Eclipse Modeling Framework | © 2006 by IBM; _
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Exercise 1.
Code Generation, Regeneration and Merge
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EMF Runtime

= Persistence and serialization of model data
» Proxy resolution and demand load

Automatic notification of model changes
Bi-directional reference handshaking
Dynamic object access through a reflective API

Runtime environments
» Eclipse
= Full IDE
= RCP
= Standalone Java
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Persistence and Serialization

load ResourceSet

resource 1

Client ——— 9 uril | resource 1
uri 2 resource 2
%'emand load
Resource 1 resource 2 Resource 2
}
VAR \
< 0O O/ 0
O 0

= Serialized data is referred to as a resource

» Data can be spread out among a number of resources in a
resource set

= One resource is loaded at a time, even if it has references to
objects in other resources in the resource set
» Proxies exist for objects in other resources
= Lazy or demand loading of other resources as needed
= A resource can be unloaded
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Resource Set

= Context for multiple resources that may have references among
them

» Usually just an instance of ResourceSetimpl, or a customized
subclass

Provides factory method for creating new resources in the set:

ResourceSet rs = new ResourceSetimpl();
URI uri = URI.createFileURI ("'C:/data/po.xml'");
Resource resource = rs.createResource(uri);

Also provides access to the registries, URI converter, and default
load options for the set
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Resource Factory Reqistry

» Returns a resource factory for a given type of resource
» Based on the URI scheme or filename extension
» Determines the type of resource, hence format for save/load

Resource.Factory.Registry reg = rs.getResourceFactoryRegistry();
reg.getbExtensionToFactoryMapQ.put('xml*, new XMLResourceFactorylmplQ);

» For models created from XML Schema, the generated custom resource
factory implementation should be registered to ensure schema-
conformant serialization

» When running as a plug-in under Eclipse, EMF provides an extension point
for registering resource factories

» Generated plugin.xml registers generated resource factory against a
package specific extension (e.g. “po”)
» Global registry: Resource.Factory.Registry.INSTANCE
» Consulted if no registered resource factory found locally
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Package Registry

Returns the package identified by a given namespace URI
» Used during loading to access the factory for creating instances

EPackage._Registry registry = rs.getPackageRegistry();
registry.put(POPackage.eNS URI, POPackage.elNSTANCE);

Global reqistry: EPackage.Reqistry.INSTANCE
= Consulted if no registered package found locally

* Running in Eclipse, EMF provides an extension point for globally
registering generated packages

* Even standalone, a package automatically registers itself when
accessed:

POPackage poPackage = POPackage.elNSTANCE;
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Resource

= Container for objects that are to be persisted together
= Convert to and from persistent form via save() and load()
= Access contents of resource via getContents()

URI urit = URI._createFileURI ('C:/data/po.xml"");
Resource resource = rs.createResource(uri);
resource.getContents().add(pl);
resource.save(null);

= EMF provides XMLResource implementation

<PurchaseOrder>
<shipTo>John Doe</shipTo>
<next>p2.xml#p2</next>

</PurchaseOrder>

= Other, customized XML resource implementations, provided, too
(e.g. XMI, Ecore, EMOF)
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Proxy Resolution and Demand Load

50

1.xml
next
PurchaseOrder <PurchaseOrder>
0.1 <shipTo>John Doe</shipTo>
N <next>p2 . xml#p2</next>
</PurchaseOrder>
pl.xml p2.xml

next
P—proxyoRi =“p2xmi#p >

PurchaseOrder p2 = pl.getNext();
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Model Change Notification

» Every EMF object is also a Notifier
= Send notification whenever an attribute or reference is changed

= EMF objects can be “observed” in order to update views and
dependent objects

Adapter poObserver = .. Adapter
purchaseOrder. eAdapters() add(poObserver); SN
L

s

adapter.notifyChanged()T

setBillTo() > N
N

PurchaseOrder
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Model Change Notification

= Observers or listeners in EMF are called adapters
= An adapter can also extend class behavior without subclassing
= For this reason they are typically added using an AdapterFactory

PurchaseOrder purchaseOrder = ...
AdapterFactory somePOAdapterFactory = ...

Object poExtensionType = ...

1T (somePOAdapterFactory. isFactoryForType(poExtensiontype))

{
Adapter poAdapter = somePOAdapterFactory.adapt(purchaseOrder,

poExtensionType);
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Model Change Notification

= Efficient notification in “set” methods
» Checks for listeners before creating and sending notification

public String getShipTo()
{

return shipTo;

}

public void setShipTo(String newShipTo)
{
String oldShipTo = shipTo;
shipTo = newShipTo;
1T (eNotificationRequired())
eNotify(new ENotificationlmpl (this, ... );
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Bidirectional Reference Handshaking

PurchaseOrder next

0..1

Invariant imposed by the bidirectional reference:
po.getNext().getPrevious() == po

previous | 0..1

public interface PurchaseOrder

{
PurchaseOrder getNext();

void setNext(PurchaseOrder value);

PurchaseOrder getPrevious();
voild setPrevious(PurchaseOrder value);
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Bidirectional Reference Handshaking

55

pl.setNext(p3);
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Reflection

= All EMF classes implement interface EObject

* Provides an efficient API for manipulating objects reflectively

» Used by the framework (e.g., serialization/deserialization, copy
utility, generic editing commands, etc.)

= Also key to integrating tools and applications built using EMF

public interface EObject
{
EClass eClass(Q);
Object eGet(EStructuralFeature sfT);
void eSet(EStructuralFeature sf, Object val);
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Reflection Example

= Setting an attribute using generated API.

PurchaseOrder po = ..
po.setBillTo('123 Elm St.'");

= Using reflective API:

EObject po = ...

EClass poClass = po.eClass();

po.eSet(poClass.getEStructuralFeature(C'billTo"),
123 EIm St.");
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Reflective Performance

= Efficient generated switch-based implementation of reflective
methods

public Object eGet(int featurelD, ...)

{
switch (featurelD)

{
case POPackage.PURCHASE ORDER _SHIP_TO:
return getShipToQ);
case POPackage.PURCHASE ORDER __BILL_TO:
return getBillToQ);
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Reflection Benefits

» Reflection allows generic access to any EMF model
= Similar to Java’s introspection capability

= Every EObject (that is, every EMF object) implements the reflection
API

= An integrator need only know your model!

= A generic EMF model editor uses the reflection API
» Can be used to edit any EMF model
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Dynamic EMF

» Ecore models can be defined dynamically in memory
= No generated code required

= Dynamic implementation of reflective EObject API provides same
runtime behavior as generated code

» Also supports dynamic subclasses of generated classes
= All EMF model instances, whether generated or dynamic, are
treated the same by the framework

= A dynamic Ecore model can be defined by
» [nstantiating model elements with the Ecore API
» Loading from a .ecore file
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Dynamic EMF Example

61

= Model definition using the Ecore API

EPackage poPackage = EcoreFactory.elINSTANCE.createEPackage();
poPackage .setName("'po™) ;
poPackage .setNsURI (""http://www.example.com/PurchaseOrder™) ;

EClass poClass = EcoreFactory.eINSTANCE.createEClass(Q);
poClass.setName (""PurchaseOrder™);
poPackage .getEClassiTiers().add(poClass);

EAttribute billTo = EcoreFactory.elINSTANCE.createEAttribute();
billTo.setName("b1ll1To");
billTo.setEType(EcorePackage.eINSTANCE.getEString(Q));
poClass.getEStructuralFeatures().add(billTo);

EObject po = EcoreUtil.create(poClass);
po.eSet(billTo,"123 EIm St.");
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Exercise 2:
EMF Runtime and Static Model APIs
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Recording Changes

= EMF provides facilities for recording the changes made to
instances of an Ecore model

= Change Model
» An EMF model for representing changes to objects
= Directly references affected objects
» Includes “apply changes” capability

= Change Recorder
= EMF adapter

= Monitors objects to produce a change description (an instance of
the change model)
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Change Model
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¢! value - EEList

¢/ resource - EResource

ChangeDescription
+objectsToDetach
-, A b
apply() - 2
%applyAndReverse() :
+objectsToAttach
0.+
0. 0
+resourceChanges +objectChanges
ResourceChange ~ ==MapEntry=> +hey EObject
oresourceUR! - String EObjectToChangesMapEntry 4 {from ecore)

ChangeKind

<<gnumeration==

&ADD
$REMOVE
$MOVE

“apply()
$applyAndReverse()
+value | 0.7
0.1
FeatureChange +referenceValue
gfeatureMame : String 0.1
¢dataValue : String -
gset - boolean = true +referencel/alue
&/ value - EJavaObject 1
+feature
®apply(originalObject - EObject) rif*‘;”:’:’aﬁe*‘"'e
®applyAndReverse(originalObject - EObject)
+feature +feature
0.1 4
0.+
0. +listChanges
+listChanges ListChange
kind : ChangeKind
$<=0._">> dataValues : String
gindex - int = -1 FeatureMapEntry

wmoveTolndex : int
<=0 *>> fvalues : EJavaObject

‘apply(originaIList : EEList)
PapplyAndReverse(originallist - EEList)

e

featureMame : String
@dataValue - String —
@/ value : EJavaObject

+featureMapEntryValues

+referenceValues
0+
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Change Recorder

» Can be attached to EObjects, Resources, and ResourceSets
= Monitors changes to the objects and their contents trees

* Produces a description of the changes needed to return to the
original state (a reverse delta)

PurchaseOrder order = .._.
order.setBillTo(""123 EIm St.");

ChangeRecorder recorder = new ChangeRecorder();
recorder.beginRecording(Collections.singleton(order));
order.setBillTo(*'456 Cherry St.');

ChangeDescription change = recorder.endRecording(Q;

» Result: a change description with one change, setting billTo to
“123 Elm St.”
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Applying Changes

= Given a change description, the change can be applied:
= ChangeDescription.apply()
= consumes the changes, leaving the description empty
= ChangeDescription.applyAndReverse()

= reverses the changes, leaving a description of the changes
originally made (the forward delta)

= The model is always left in an appropriate state for applying the
resulting change description
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Example: Transaction Capability

= |[f any part of the transaction fails, undo the changes

ChangeRecorder changeRecorder =
new ChangeRecorder(resourceSet);

try
{

// modifications within resource set

}

catch (Exception e)

{
changeRecorder.endRecordingQ.-applivQ;

}
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Exercise 3:
Recording Changes
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Validation Framework

= Model objects validated by external EValidator

public interface Evalidator

boolean validate(EObject eObject,
DiagnosticChain diragnostics, Map Context);
boolean validate(EClass eClass, EOjbect eObject,
DiagnosticChain, diagnostics, Map context);
boolean validate(EDataType eDataType, Object value,
DiagnosticChain diagnostics, Map context);

» Detailed results accumulated as Diagnostics
» Essentially a non-Eclipse equivalent to IStatus

» Records severity, source plug-in ID, status code, message, other
arbitrary data, and nested children
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Invariants and Constraints

= |nvariant = Constraint

= Defined directly on the class, = Externally defined for the
as an operation with <<inv>> class via a method on the
stereotype validator
= Stronger statement about 2l
. g . General I Detail I Operations I Attributes I Relations |
validity than a constraint Componerts | Nesied | Fles | DL Ecor
Set:  |slEEN - Edit Set... |
* Model Properties
= | Namfa_ |‘u"ah.|e |Sourc::le |
PurchaseOrder 'Il'f”m v -
billTo : String

<<inv>> validAddresses()

Dvenidel Defautt | Revert |

[ ok | concel | ook | Browse~| Hep |
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Generated EValidator Implementations

» Generated for each package that defines invariants or
constraints

= Dispatches validation to type-specific methods

= For classes, a validate method is called for each invariant and
constraint

» Method body must be hand coded for invariants and named
constraints
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Schema-Based Constraints

= |[n XML Schema, hamed constraints are defined via annotations:

<xsd:annotation>
<xsd:appinfo source="http://www.eclipse.org/emf/2002/Ecore"’
ecore :key=""constraints'>VolumeDiscount</xsd:appinfo>
</xsd:annotation>

= Also, constraints can be defined as facets on simple types, and
no additional coding is required

» Constraint method implementation generated

<xsd:simpleType name="'SKU"">
<xsd:restriction base=''xsd:string'>
<xsd:pattern value="\d{3}-[A-Z]{2}"/>
</xsd:restriction>
</xsd:simpleType>
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Framework EValidator Implementations

» EODbjectValidator validates basic EObject constraints:
= Multiplicities are respected
= Proxies resolve
= All referenced objects are contained in a resource
» Data type values are valid

» Used as base of generated validators and directly for packages
without additional constraints defined
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Framework EValidator Implementations

= Diagnostician walks a containment tree of model objects,
dispatching to package-specific validators
= Diagnostician.validate() is the usual entry point
= Obtains validators from its EValidator.Registry

Diagnostician validator = Diagnostician. INSTANCE;
Diagnostic diagnostic = validator.validate(order);

iIT (diagnostic.getSeverity() == Diagnostic.ERROR)

// handle error

}

for (lterator i = diagnostic.getChildren().iterator(); i.hasNext();)

{
Diagnostic child = (Diagnostic)i.next();
// handle child diagnostic

}
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Exercise 4:
Validation
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XML Processor

= New in EMF 2.2 (from M2)

= Simplified API for loading and saving XML
» Handles resource set, registries, etc. under the covers
= Can automatically create a dynamic Ecore representation of a

schema
» Load/save instance documents without generating code

= Manipulate the objects using reflective EObject API

URI schemaURI = ...
String instanceFileName = ...

XMLProcessor processor = new XMLProcessor(schemaURl);
Resource resource = processor. load(instanceFileName);

EObject documentRoot = (EObject)resource.getContents.get(0);
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Exercise 5:
Reflection, Dynamic EMF and XML Processor
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What's New in EMF 2.2

* Plan items [Bugzilla]:
= XMLProcessor utilities to improve ease-of-use [104718]
» EMF.Edit enhancements [105964]
= Content adapter for managing reverse of 1-way references [75922]
» Cross-resource containment [105937]
= XMI 2.1 support [76538]
» Improve XML Schema generation [104893]
= Model exporter [109300]
» Decouple JMerger implementation from JDOM [78076]
» Performance optimizations [116307]
» Make code generator more extensible [75925]
= Improve code generation error reporting and handling [104727]

» For more, see http://www.eclipse.org/emf/docs.php#plandocs

82 | Introduction to the Eclipse Modeling Framework | © 2006 by IBM; _




@p CON 2006

What's New in EMF 2.2

= Community Involvement
= EMFT: incubating new EMF Technology projects:
= Object Constraint Language (OCL)
= Query
Transaction
Validation
EMF Ontolgy Definition Metamodel (EODM)
Java Emitter Templates (JET)

= See http://www.eclipse.org/emft/
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Summary

= EMF is low-cost modeling for the Java mainstream
= Boosts productivity and facilitates integration

* Mixes modeling with programming to maximize the effectiveness
of both
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Summary

= EMF provides...

= A metamodel (Ecore) with which your domain model can be
specified
= Your model can be created from UML, XML Schema or
annotated Java interfaces

= Generated Java code
= Efficient and straightforward
» Code customization preserved
» Persistence and Serialization
» Resource-based serialization
» Proxy resolution and demand loading

» Default resource implementation is XMI (XML metadata
interchange), but can be overridden
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Summary

= EMF provides...
= Model change naotification is built in
= Just add adapters (observers) where needed
= Reflection and dynamic EMF
» Full introspection capability
= Simple change recording and roll-back
= Extensible validation framework
= Standalone runtime support

» A Ul-independent layer for viewing and editing modeled data
(EMF.Edit)
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Resources

» EMF documentation in Eclipse Help
= Qverviews, tutorials, API reference

= EMF Project Web Site
= http://www.eclipse.org/emf/
= Qverviews, tutorials, newsgroup,
Bugzilla
» Eclipse Modeling Framework
by Frank Budinsky et al.

» Addison-Wesley; 1st edition
(August 13, 2003)

= [SBN: 0131425420.

feclipse

Farewond by Sridhar yengar

echi

Frank Budinsky « David Steinbery

Edl Merks - Ray Ellersick - Timothy J. Girunss

ToRs +  Erich Gamma - Lee Mackman - John Wiegand
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Legal Notices

IBM, Rational, WebSphere, Lotus, and Rational Rose are
registered trademarks of International Business Machines Corp. in
the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun
Microsystems, Inc. in the United States, other countries, or both.

Other company, product, or service names may be trademarks or
service marks of others.
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